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Overview Related links 

You don't need a big budget to develop your own marketing materials. This How-To Guide will 
show you how easy it is to create professional-quality brochures quickly and inexpensively. We'll 
take a closer look at some of the benefits and give you advice on targeting your audience and 
planning your message. Then we'll show you how to bring your brochure to life with easy-to use Related courses 
templates and choose the proper business media to put your business in the spotlight. 

» Understand it: it's easy, it'll save you money, and it works -- discover the many benefits of do-it-yourself marketing. 

» Plan it: pinpoint your audience and your message with these tips. 

» Do it: customize HP business brochure templates by adding your own photos, artwork, and text. We'll take you through 
the process step by step. 

» Use it: pick up great ideas for distributing your brochure. 

» Buy it: shop for the products you need to create and print your own business collateral. 

» Understand it 

» Office templates 
» Color printing center 
» Digital photography for your business 
» Direct marketing guide 

The HP Learning Center offers a variety of courses related to 
creating a marketing brochure. Visit it today and look for: 

● Adobe Photoshop 7 basics 
● Advanced Photoshop applications 
● Design your own business documents 
● Digital photography for your business 
● Scanning basics 

Printable version 
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» Overview 
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Understand it Related links 

A marketing brochure can boost your sales efforts instantly. And by creating those materials in­
house, you can save both time and money. Whether you're a real estate agent or caterer, the 
power of a good brochure that delivers your message with visual impact cannot be overestimated. 

Related courses 
Let's take a closer look at some of the benefits: 

Save money 

With a high-quality printer and the right paper, it's easy to create your own marketing materials 
inexpensively. Plus, you can print only what you need, when you need it, eliminating the cost of 
overruns and preventing stacks of dusty, outdated brochures from gathering in the corners. 

Stay in touch 

» Office templates 
» Color printing center 
» Digital photography for your business 
» Direct marketing guide 

The HP Learning Center offers a variety of courses related to 
creating a marketing brochure. Visit it today and look for: 

● Adobe Photoshop 7 basics 
● Advanced Photoshop applications 
● Design your own business documents 
● Digital photography for your business 
● Scanning basics 

Brochures are a great way to stay in touch with current customers, build loyalty, and strengthen 
your credibility. And, since you can print your own marketing materials instantly, it's easy to 
create small runs of customized materials for specific customers, presentations, or tradeshows. 

Generate revenue 

It's simple: Customers who better understand your business as a result of your marketing 
brochure will be more likely to spend money with you. Color, in particular, can be a great 
communication tool -- it can boost customer comprehension by 75 percent and accelerate 
learning from 55 to 75 percent. 

Ideas in action: real estate 

Imagine -- photos of your prime real estate properties displayed in brilliant color. Once you take 
your digital pictures, it's easy to scan your images, drop them into one of HP's customizable 
Microsoft Word templates, and print beautiful full-color brochures. Plus, since you can create your 
materials as you need them, you can continually update your brochure when hot new properties 
hit the market. 

Read on for tips on planning your brochure's look and message. And learn how to use the brochure templates to 
your advantage. 

» Plan it 
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Plan it Related links 

Buying options 
» Shop online at HP A great marketing brochure delivers a clear, focused message in a visually compelling way. 
» Other ways to buy Finding that focus requires forethought about who will read the brochure and how you can convey 
» Business to business a unique benefit to them. Below, you'll learn tactics for targeting the audience for your brochure 

» Office templates 
» Color printing center 
» Digital photography for your business 
» Direct marketing guide 

and receive tips for crafting your message. Related courses 
Or call 800-888-0262 

Start with the audience 
The HP Learning Center offers a variety of courses related to 
creating a marketing brochure. Visit it today and look for: 

● Adobe Photoshop 7 basics 
● Advanced Photoshop applications 
● Design your own business documents 
● Digital photography for your business 
● Scanning basics 

» Special offers 
» News & Events 
» Request catalog & news 

Knowing whom you want to read your brochure will help you craft the message. Begin by 
narrowing your audience to the customers who will best help you increase business. Your 
individual business situation will dictate who that is. 

Sometimes it's best to target customers who already know and trust your business -- especially if 
you're introducing a new service. But often you'll have more success marketing to new prospects. 
A small business consultant who specializes in your industry can help you research potential 
customers and tailor a message for them. 

Pinpoint what makes you unique 

Glean insights by listening to your customers, employees, and salespeople. You might be 
surprised by what draws people to your business and distinguishes you from the competition. 
Maybe it's that they can always find a parking spot near your store. Or maybe it's that they trust 
your real estate advice because you live in the same neighborhood where you sell homes. 

Ask your customers for their opinions in an offhand, personal way -- they'll be more likely to tell 
you the first thing they think of, which is often the most honest answer. Write these thoughts 
down so you don't lose or forget them. They don't have to be complete sentences -- short 
fragments that express the point will work perfectly when you need to write headlines and 
captions for your brochure. 

Prioritize these thoughts and ideas based on the business objectives the brochure is helping you 
meet. But keep your message focused; you'll want to emphasize just one or two of your 
objectives. 

Understand what the reader sees 

It's a good idea to mock up a brochure on a piece of paper and decide in advance where the 
photos and text will go. Years of testing has found that readers see elements on your page in a 
certain order almost every time: 

1. Pictures or illustrations 

2. Headlines 

3. Charts or graphs 

4. Captions 

5. Body copy 

Many readers, even if they have a vested interest in the brochure, will only skim the body copy. 
Knowing that, spend your time and energy appropriately. Make sure your headlines, illustrations, 
and photos tell most of your story. Body copy is important, but don't bury your most important 
points there. 

Plan your message 

Now it's time to gather your notes and get down to the business of writing. Write clearly and 
plainly, avoiding jargon and buzzwords, and always aim to explain your point in a unique and 
interesting way. Remember to make your headlines tell your story so that even if someone simply 
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skims your brochure, they will still receive the main points.


You also may want to hire a writer or business consultant to help you hone your message.


Present a call to action 

An often-overlooked step in planning and writing brochures is the "call to action." It's important to 
call out the next step for the reader. For example, if you want the reader to come into your store, 
find a way to make that action more compelling. Perhaps a coupon, in-store discount, or special 
event would spur them into motion. 

Say it with pictures 

Pictures and illustrations are almost always the first thing readers look at in brochures. Think 
about it: No amount of text description, however well written, is going to convey the beauty of a 
real estate property to a potential buyer. 

It doesn't take a professional photographer to capture the products, quality, and spirit of your 
business. Digital cameras make it easy for anyone to capture professional-quality pictures that 
can be downloaded for use in a brochure. 

Artwork that works 

Bearing in mind what your main message is, find artwork that complements it. Be very 
discriminating; remove any artwork that doesn't fit with the message. If you don't have many 
pictures or illustrations on hand, you might consider free clip art. HP offers free art you can 
download, or you can look through the free Microsoft Clip Art Library. You can explore it by 
opening Microsoft Word, then selecting Insert > Picture > Clip Art. 

Experts also suggest staying with one style, so choose either photos or illustrations. 

Choose the right equipment 

To create a professional-quality full-color brochure, you need the right combination of products. 
Here's a look at three of the most important components: 

● Printer -- HP Color LaserJets give you high-speed color laser printing at an affordable 
price (perfect for printing brochures in large quantities). They print up to 600 x 600 dpi 
quality with HP ImageRET 2400 for crisp text, bold graphics, and vivid images. 

● Scanner -- Get all your photos organized and enjoy great scanning at your fingertips. 
HP's Scanjet 5530 Photosmart scanner is the best way to quickly and easily convert 
stacks of traditional standard-size photos into digital files for printing, e-mailing, and 
storing. 

●	 Digital Camera -- Use HP's big zoom camera, the HP Photosmart 945 digital camera 
to add impact to your marketing materials. With 5.3 MP total, 56x total zoom, 8x 
precision optical lens and 7x digital, it delivers beautiful photos and enlargements. One-
touch, fully automatic technology delivers great shots with manual overrides for adding 
creative touches. 

Choose a brochure template 

While you could hire a freelance designer to create the brochure, HP offers several free 
professional-looking brochure templates that you can easily manipulate in Microsoft Word, then 
print yourself. The next section will give you tips and step-by-step instructions for using these 
templates. 

» 	 Do it 

Printable version 
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Do it	 Related links 

Buying options 
» Shop online at HP Once you've selected your brochure template and established your message, it's time to get 
» Other ways to buy down to the business using HP's Microsoft Word brochure templates. Even if you decide to create 
» Business to business a brochure using other software, these tips and guidelines for writing, designing, and printing can 

still help you produce a professional-looking piece. Related courses 

» Office templates 
» Color printing center 
» Digital photography for your business 
» Direct marketing guide 

Or call 800-888-0262 

Insert your headlines and copy 

The HP Learning Center offers a variety of courses related to 
creating a marketing brochure. Visit it today and look for: 

● Adobe Photoshop 7 basics 
● Advanced Photoshop applications 
● Design your own business documents 
● Digital photography for your business 
● Scanning basics 

» 	 Special offers 
Replace the sample text in the brochure with your own text. And remember to proofread after» 	 News & Events 

» Request catalog & news	
you're done (even if it's been edited once before.) An easy way to catch typos is by reading the 
text and headlines to yourself out loud. Ask someone else to read it too, looking both for errors as 
well as phrases that might be confusing. 

Add photos and artwork 

Some of the templates come with a Photo Socket, which is a placeholder for digital images. To 
add your art, first select and delete any text in the box. Then go to the Insert menu, and select 
Picture. If you're using Microsoft Clip Art, choose Clip Art. More likely you're using digital pictures 
or charts. Choose Insert > Picture > From File, then browse your hard drive to locate the right 
picture. 

Before you insert the picture, choose from one of three options: 

1. 	Autocrop to Selection Size - This automatically fits your photo into the Photo Socket. 
It may crop the edges of large photos. 

2. 	Center in Selection Space - This centers your photo in the middle of the Photo 
Socket. 

3. 	Align with Top Left Corner - This places your photo in the top left corner of the Photo 
Socket. 

Remember to touch up, crop, or otherwise improve your image using your favorite photo- or 
image-editing software before inserting the image in Microsoft Word. 

Communicate with color 

Don't feel obligated to use the colors suggested in the templates. Experiment! You might consider 
choosing your brochure colors the way you'd choose your work clothes -- deep, rich, darker 
colors for more conservative and traditional industries, or light, vibrant, and modern shades for 
businesses that emphasize a friendly, personal touch. Try to limit the number of colors you use to 
two or three, and choose complementary colors that go with the hue and lightness of your art. 

Save your work 

Brochure files can be quite large when you add image files. If you make several brochures to 
target different audiences, consider making a back-up on CD to save your hard drive space. Also, 
be sure to save your Microsoft Word document every few minutes to help prevent disasters in the 
event that the computer crashes or the power suddenly goes out. 

Print a test copy 

Producing a "proof" on plain paper allows you to check your picture placement and color. It also 
helps you practice your two-sided printing directions and saves the valuable specialty paper you'll 
use for the final brochure. Using plain paper, follow the directions for two-sided printing in 
Microsoft Word. Try marking the top of the paper before you print. (This may help you visualize 
how both sides of the paper flow through the printer.) 

For your test copy, it's fine to print in draft mode to save ink and money. But when you print your 
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final pieces, you'll want to use the highest-quality setting, especially if your using artwork or 
photos. 

While you're making corrections, take the time to have someone check the text -- again -- for 
typos. 

Choose the right paper 

You've spent the time and energy producing a beautiful electronic file, but now it's time to bring 
your brochure to life -- on paper! Your paper choice can have a significant impact on the look and 
feel of your final piece. Look for a high-quality paper that's thick like a greeting card, but that will 
allow the colors and pictures to really shine. 

Your best media option for a laser printer is HP Soft Gloss Laser Paper. It's a print shop-quality 
soft gloss paper that's coated on both sides for vivid color and professional black text -- an ideal 
choice for brochures. 

Print and produce your brochure 

From the File menu, select Page Setup. Choose Best for the Print Quality, and choose HP 
Professional Brochure & Flyer for the Paper Type. Then click the Save Settings button. 

Here are some more tips for getting the most from your new brochure: 

●	 To avoid ink smears, set the pages aside to dry completely in between printing on the 
front and back. 

●	 Rather than printing several brochures right away, create a prototype. This will allow 
you to make a final test of colors, placement, text, and two-sided printing. 

●	 After creating a prototype, write down any special directions if the folding, binding, and 
cutting are complex. 

●	 To extend the physical life of your brochures, store them in a dark, dry place where 
harmful rays of sunlight can't damage them. Also, keep them where the temperature 
won't fluctuate too much. 

» 	 Use it 

Printable version 
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Use it Related links 

Buying options 
» Shop online at HP Brochures are valuable tools--but they only fulfill their full potential when you can effectively get 
» Other ways to buy your message into the hands of your target audience. We'll take a look at several innovative ways 
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» Direct marketing guide 

Related courses 
Or call 800-888-0262 Direct mail 

» Special offers 
» News & Events 
» Request catalog & news 

The best way to get literature to your target audience is usually not by a mass mailing or other 
means of unsolicited distribution. Unsolicited brochures (and even solicited ones) are rarely read. 
At best, they end up lost in a file drawer. Plus, for every two or three active leads, you'd have to 
send out thousands of brochures, which will most likely be thrown away. 

But that's not to say that direct mail can't be effective. It depends on the type of business you're in 
and the quality of your list. Advertising a new offer to a list of tried-and-true customers, for 
example, could work remarkably well. But an equally excellent offer, even with a striking design 
and powerful copy, can fail if mailed to the wrong list. 

Just know that it's important to use the most accurate and up-to-date lists possible to increase 
your margin of success. It's also vital to set up a system to add names--and keep them current. 
And it is imperative that repeat mailings be made--a common error is not mailing often enough. If 
you've got a good list, take advantage by keeping in touch frequently. 

Where the consumers are 

The best way to get information to a prospect is to have your brochure available at places and 
times when they're more responsive to your service--when it's already on their mind. 

You could advertise your pet-sitting services by going door to door with brochures or fliers. But 
why not place the brochure in the waiting areas of veterinary offices where people are looking for 
something to read, or grooming and specialty shops where pet owners are apt to ask for referrals? 

If you're in the travel industry, then check out the local Chamber of Commerce, visitor's center, 
and other places where people come looking for materials. 

Conferences, seminars, trade shows 

There are a variety of ways to distribute your brochures at conferences. You could slide materials 
under the hotel room doors of conference attendees the day they arrive, hire people to pass them 
out at the convention, or find marketing partners in your industry who will distribute your 
brochures at their booths. 

People who request information rather than just grab a brochure are usually very good leads. 
Take along a notebook computer that's equipped with database software so prospects can type 
their own names and addresses into the database to receive a brochure later. 

Inserts 

Forming a partnership with a publication whose readership fits your target audience is another 
great way to approach prospects in a timely way. For example, you could include an insert for 
your childcare service in a local parenting magazine. 

Website download 

The HP Learning Center offers a variety of courses related to 
creating a marketing brochure. Visit it today and look for: 

● Adobe Photoshop 7 basics 
● Advanced Photoshop applications 
● Design your own business documents 
● Digital photography for your business 
● Scanning basics 

If you have a website, consider providing a downloadable version of your brochure for people to 
print themselves. Even providing a way for prospects to request a copy can help you collect some 
more qualified leads. 

However you choose to distribute your brochure, it's always important to track the results. 
Including a coded special offer can help you gauge the success of a piece. A benefit of creating 
your own marketing materials is that you can easily change and evolve your message as you 
learn what's effective and works best for you. 
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United States-English 

» Contact HP 
Search: 

Small & Medium Business All of HP United States 

Solutions - how-to guides


» Small & Medium Business 
Create marketing brochures 

» Products 
» Solutions 

» How-to guides 
Create marketing brochures 

» Support & Drivers 
» Services 

» Overview 
» Understand it 
» Plan it 
» Do it 
» Use it 
» Buy it 

Buy it Related links 

Buying options 
» Shop online at HP » Color HP LaserJet printers 

» Other ways to buy 
» Business to business 

» Office templates 
» Color printing center 
» Digital photography for your business 
» Direct marketing guide 

• Laser color as competitively priced as black and white 

• High quality color output Related courses 
Or call 800-888-0262 

• Easy to use and maintain 

• Compact design that is easily upgradeable 

» Special offers 
» News & Events 
» Request catalog & news or call 800-888-0262 

The HP Learning Center offers a variety of courses related to 
creating a marketing brochure. Visit it today and look for: 

● Adobe Photoshop 7 basics 
● Advanced Photoshop applications 
● Design your own business documents 
● Digital photography for your business 
● Scanning basics 

» Find a local store 
» Other ways to buy 

» Business inkjet 3000 printer 

or call 800-888-0262 

» Find a local store 
» Other ways to buy 

» HP Photosmart 945 digital camera 

• High-performance network color printing 

• Fits into your network like a laser printer 

• Economical ink supplies management 

• Produce high-quality, accurate business documents 

or call 800-888-0262 

» Find a local store 
» Other ways to buy 

» HP Scanjet 4670 scanner series 

With 5.3 MP total, 56x zoom (8x optical, 7x digital), HP 
Instant Share, 32 MD Secure Digital (SD) card included, the 
HP Photosmart 945 digital camera captures it all with 
brilliant quality. 

HP scanning technology meets breakthrough vertical design 
in the HP Scanjet 4670. This ultra-thin scanner with a see­
thru window of tough polycarbonate saves space by 
standing vertically on the desktop. Preview scans in as little 
as six seconds and scans at 2400 dpi optical resolution with 
48-bit color for sharp, clear photos. 

or call 800-888-0262 

» Find a local store 
» Other ways to buy 

» HP Soft Gloss Laser Paper 
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HP LaserJet Soft Gloss Paper delivers top-quality text, 
photos, and graphics for high-impact results on all your 
important business materials. 

or call 800-888-0262 

» Find a local store 
» Other ways to buy 

» Return to marketing brochure index 

Printable version 

Privacy statement Using this site means you accept its terms Feedback to SMB webmaster 

© 2005 Hewlett-Packard Development Company, L.P. 
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